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Getting Started 

Welcome 
What's in a name? Shakespeare penned this line hundreds of years ago, and now First Name 
Almanac brings the answer to that question right to your fingertips. Not only does this amazing 
software tell you what is in a name — its meaning, its history, lucky numbers and astrological 
signs associated with it and more — First Name Almanac can tell you what lies behind more than 
250,000 names! 

And that's just the tip of the iceberg. First Name Almanac also gives you the power to use all 
those names to create dazzling printouts that are sure to sell. Certificates, desk name plates, 
wearable buttons, custom-tailored leave-behinds, family trees, Christmas ornaments, coffee 
mugs, letters from Santa — all this and more can be created right from your computer and sold to 
happy customers. 

The program will even create a poem using each letter of any first name. First Name Almanac 
Pro supports color printers and gives you complete control over your color selections. The 
possibilities are endless. 

First Name Almanac is a proven money-maker with a 22-year track record among people from 
many walks of life. Professionals, from health care providers to insurance agents, can use First 
Name Almanac to create personalized certificates for their clients, which will increase customer 
loyalty as well as enhance the professionals' name recognition. Fund raisers can use First Name 
Almanac to create personalized spill-proof cups, can-coolers, and key-chains to raise 
contributions for their schools, churches, scout troops or fraternal organizations. Entrepreneurs 
can use First Name Almanac to create personalized mugs, steins, and jewelry boxes, starting a 
new business with a modest capital investment. Corporations can use First Name Almanac to 
create dazzling certificates, desk name plates, wearable buttons and custom- tailored leave-
behinds, eliminating the need to buy expensive personalized gifts for their employees, customers 
and prospects. 

  

 

What's New in This Version  

Date Version Type Comments 

24 Feb 2013 12.2 Minor Added checkbox to Single Name and Dual 
Names to allow you to Omit Personality traits' 
headings and bullets. Give a more "clean" look 
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to printout. Checkbox is located at bottom of 
personality traits in both single and dual names. 
When checked, headings like "Emotional 
Spectrum" and bullet following won't print. 
Sticky. 

10 Sep 2011 12.0.0 Major Introducing Persistent Activation. On same 
physical machine, the software activation and 
registration will import to each new version of 
the program. No need to re-register when 
upgrading even if you totally un-install the 
software, the new re-install will self-register. 
Same applies to all Live Updates to program. 

11 Oct 2010 11.93 Minor New Background Artwork update 

21 Mar 2010 
  

11.91 

  

Minor Corrected some British English dictionary 
errors in Letters to Santa and Easter Bunny. 

08 Nov 2009 11.9 Major Windows 7 Native Mode Compatibility. 
Now compatible with Windows XP, Vista & 7 

08 Aug 2009 
  

11.8 Minor Added new art background releases from All 
About Names. Live Update is now moved 
outside the program into the Program Group. 

08 Aug 2009 11.7 Major Windows XP, Vista [32 & 64-bit] 

No longer requires that UAC in Vista be turned 
off. 

22 Nov 2008 11.6 Minor Updated internal controls as some mouse clicks 
were not recognized when changing 
male/female, etc. Occurred mostly on laptops. 

Better Windows Vista compatibility. 

Deleted old registration method by disk. Now 
choice of offline (telephone) or instant online 
activation. Old registration floppies and CD's 
will no longer work. 

20 Oct 2008 11.5 Minor Added ability to export/import favorites to/from 
an external disk. Available under file menu. 
Helpful when installing First Name Almanac on 
a new computer. Saves trouble of re-creating 
your saved favorites. 

10 Mar 2008 11.4 Major Now Windows Vista Compatible 

Add HTML Context-Sensitive Help 

Print-on-Demand full color, user manual 

Now installs with high-end, intelligent  Windows 
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MSI installer. Windows Vista Certified. 

Installer signed with Microsoft Authenticode 

15 May 2006 11.2 Update Added support for southern hemisphere 

Astrology Sun Sign Dates. Enable in 
Preferences Page. 

Fixed bug in Reverse Mirror Printing 

Added "Preserve Sentiment Line" to keep same 
tag line from name to name. 

19 Mar 2006 11.1 Major 
Update 

Added Optional Ornate Font as Name Headline 

Accessed just before printing under font 
options. Reverse Mirror Printing & PDF creation 
not available with this font option. Pro version 
only 

06 Jan 2006 11.0 Major 
Update 

Added  Internet Activation 

Added ability in Internet Activated version to 
edit dealer tag line. 

06 Dec 2005 10.9 Minor 
Update 

Corrected Typo in Letter from Santa 

01 Oct 2005 10.8 Minor 
Update 

Added New Letter from Santa Background 

08 May 2005 10.7 Minor 
Update 

Added extensive error handling 

21 Feb 2005 10.6 Minor 
Update 

Added a bold font Nero Bold for improved 
readability on intense backgrounds. 

04 July 2004 10.5 Major 
Update 

Optional Sentiment line now saves last 50 
entries. Re-use any sentiment from drop-down 
box or type a new one. 

Note: resets to default after printing so that the 
tag line doesn't accidently print on next new 
name. The previous tag line can always be re-
selected. 

Eliminated flourish before and after name in 
keychains only. Put long names with flourish 
outside printable border. 

30 May 2004 10.4 Major 
Update 

Corrected problem using private database for 
both names in dual names. 

Corrected problem with "00" being defaulted in 
day of the month after entering a single digit 
date. 
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10 May 2004 10.3 Major 
Update 

Corrected problem with fonts not embedding 
correctly in PDF. 

14 May 2004 10.2 Major 
Update 

Corrected problems with LIVE UPDATE 

07 May 2004 9.9.1 Major 
Update 

Background artwork is now separated from the 
program and placed in its own common file 
subdirectory. 

The artwork is now shared by all our software 
that uses these images. This will eliminate 
repetitive downloads of the same art, when only 
the software itself changes. The backgrounds 
are now available as a separate download. 
Click here to download 

Corrected some minor internal errors. 

30 Apr 2004 9.9 Major 
Update 

Overhauled the Preferences section. Now you 
may select and save your startup defaults as a 
group. And this time it actually works :-) 

Fixed major bug in N is for Names section when 
using a  l-o-n-g name. Now proportions are 
correct. 

29 Apr 2004 9.8 Major 
Update 

Added ability to save and load favorites 
(memory settings). For more info see: Load & 
Save Favorites This is a similar function to the 
old Memory Buttons, but expanded. Make sure 
you read the above link to understand this new 
feature. 

Corrected problems with N is for Names when 
using British English. 

Expanded number of entries available in N is 
for Name from 13 to 24. Formerly name was 
limited to 13 characters. 

27 Apr 2004 9.7 Minor 
Update 

Corrected some problems with "Live Update" 

Corrected Problem with not recognizing PRO 
version after update or re-install 

25 Apr 2004 9.5 Minor 
Update 

Corrected spacing in "N" is for Names 

25 Apr 2004 9.4 Major 
Update 

Added Dual Name Graphics to print  between 
two names. Optional. Select the desired graphic 
on the page where you select the background 
image. Exemplar available to print. 

Simplified choice of Lucky Numbers, 
inspirational verses or nothing. Now on main 
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input page as a radio button selection. 

Added optional year to birthdate. If a year is 
entered, it will print. Available on anything that 
prints the birthdate.   

Artists who own copyrights to the background 
images now require us to watermark the display 
images you see on the screen with "For Display 
Only". Does NOT print on the actual pre-printed 
background images. Protects copyright owner 
from theft of the low-resolution images. If you 
use or display these images in any form, you 
must use these watermarked versions. Does 
NOT affect the paid, pre-printed versions you 
buy and actually print on. 

21 Apr 2004 9.3 Minor 
Update 

Corrected various minor bugs 

21 Apr 2004 9.2 Minor 
Update 

Corrected Adobe PDF Creation in "N is for 
Names " 

Corrected empty Help Menus 

21 Apr 2004 9.1 Minor 
Update 

Corrected Font Installation Problem 

20 Apr 2004 9.0 Major 
Update 

Initial release of 32-bit version 

 

Quick Start Guide  
This Quick Start Guide should get you up and running in no time. Although First Name Almanac 
offers many powerful features for customization, each section of the program involves only a few 
basic steps, which are explained below. For further details on each program section, refer to the 
other sections of this manual. 

This Quick Start Guide is divided into separate sections for the following areas of the application 
(refer to the screen shot of the main menu below): 

  Preview and Print Meaning of Single or Dual Names – Design and print a document that 
explains a name's meaning, history and other traits. You can also create a document that 
displays this information for two names side by side. 

  Mugs & More – Design and print documents that can be applied to specialty products 
such as mugs, coasters and Christmas ornaments. 

  Family Tree of Life – Create and print a detailed family tree. 

  'N' is for Name – Print a clever poem that examines the meaning of each letter of a 
name. 

  Letters from... – Customize a letter to a child from Santa Claus, the Easter Bunny or 
Tooth Fairy. 
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Preview and Print Meaning of Single or Dual Names 

To print single or dual names: 
1. From the main menu, select one of the following options: 

 Preview and Print Meaning of Single Name 

 Preview and Print Meaning of Dual Names 

2. Enter a first name and select the appropriate gender. Then click Lookup Meaning and 
Traits to retrieve that information from the database. The meaning and traits will display 
to the right in the Edit All Properties area. You can edit this information as needed. For 
details see Step 1: Enter First Name . 

3. If you are printing the meaning of dual names, click the Enter Name 2 of 2 tab and enter 
the second name. 

4. Click the Select a Background tab and select the proper background art. 

5. Click the Customize and Print tab and customize the print settings. Preview the 
document , and then print it .  You can also choose to create a PDF that you can e-mail 
to your customer. 

That's all there is to it! 

Mugs & More 

To create printouts using Mugs & More: 
1. From the main menu, select Mugs & More. 

2. Enter a first name, select a gender and edit the name properties as you see fit. 

3. Click the Select a Specialty Product tab and select the product for which you want to 
create a printout. 

4. Click the Select a Background tab and choose the appropriate background art. 
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5. Click the Customize and Print tab and customize the print settings. Preview the 
document , and then print it .   

Family Tree of Life 

To create a Family Tree of Life: 
1. From the main menu, select Family Tree of Life. 

2. Enter the family surname in the upper-left corner of the tree and then fill in the names and 
birthdates of the family members on the branches of the tree. 

3. Preview the document , and then print it .   

'N' is for Name 

To create printouts using 'N' is for Name: 
1. From the main menu, select 'N' is for Name. 

2. Enter a first name and select the appropriate background art. 

3. Click the Step 2: Select Options and Print tab and customize the print settings. Preview 
the document , and then print it .  You can also choose to create a PDF that you can e-
mail to your customer. 

Letters From... 

To create printouts using Letters from...: 
1. From the main menu, select Letters from.... 

2. Enter a child's name and address, select a gender and choose the appropriate letter. 

3. Click the Step 2: Select a Background tab and choose the background art. 

4. Click the Step 3: Customize and Print tab and customize the print settings. Preview the 
document , and then print it .  You can also choose to create a PDF that you can e-mail 
to your customer. 

Home Screen Menu Options  
The Main Menu 
The main menu gives you access to the other sections of the application, as well as the PDF 
Preferences and printed user manual. 

Note: You can return to the home screen at any time by clicking the Home button found on 
various screens throughout First Name Almanac. 

Preview and Print 
Meaning of Single 
Name 

Design and print a document that explains 
a name's meaning, history and other traits. 

Preview and Print 
Meaning of Dual 
Names 

Print the meaning of two names side by 
side. 

Mugs & More Design and print documents that can be 
applied to specialty products such as 
mugs, coasters and Christmas ornaments. 
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Family Tree of Life Create and print a detailed family tree. 

'N' is for Name Print a clever poem that examines the 
meaning of each letter of a name. 

Letters from ... Customize a letter to a child from Santa 
Claus, the Easter Bunny or Tooth Fairy. 

PDF Preferences Allows you to set the PDF e-mailing 
preferences . 

Print User Manual Prints the user manual for First Name 
Almanac. The printed version contains the 
same information as the online help file. 

Quit Closes the application 

 

The Top Menu Bar 
Across the top of the screen, you'll see a menu bar that provides the following options: 

 

File Menu 
The File menu provides the following options: 

 

Print Setup Allows you to set up your printer to work 
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with the software 

Send a Selected PDF 
File via Email 

Lets you e-mail a PDF file that has already 
been created 

Exit Closes the application 

Edit Menu 
The Edit Menu provides the following option: 

 

Edit Private Name 
Database 

Allows you to edit the private name 
database, where you can save and edit 
your own names and meanings. 

Special Menu (Before Activation) 
Before you activate the software, the Special menu provides the following options: 

 

Reset Count Lets you reset the print counter  

Registration Disk on 
Floppy 

Registers the software via floppy disk, an 
alternative to Internet registration 

Registration Disk on 
CD 

Registers the software via CD, another 
alternative to Internet registration 

Internet Activation Allows you to activate the software so that 
you can take advantage of its full features. 

Special Menu (After Activation) 
After you activate the software, the Special menu provides the following options: 

o 
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Reset Count Lets you reset the print counter  

DE-Activate This 
Software 

Deactivates the software. If you want to 
install First Name Almanac on a different 
computer, you will first have to deactivate it 
on your first computer. 

Edit Dealer Info Lets you modify the dealer information that 
appears at the bottom of printouts and 
PDFs. 

Count Indicator 
The count indicator lets you know how many documents and PDFs you have created. You can 
reset this counter to zero if necessary. 

Live Update Menu 
The Live Update menu provides the following options: 

 

Update Software Allows you to check for updates over the 
Internet and schedule automatic updates to 
occur periodically. 

Update Art 
Backgrounds 

Checks for updates to the background art 
used throughout the program. 

Preferences Menu 
The Preferences menu provides the following option: 

 

General Options and 
Preferences 

Opens the General Options and Preferences 
screen , where you can specify a number of 
default settings. 

View Menu 
The View menu provides the following options: 
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View PDF Folder Opens the folder in which PDFs generated 
by the program are saved ( Error! Hyperlink 
reference not valid. ). 

Help Menu 
The Help menu provides the following options: 

 

Contents Opens the online help file. 

What's New This 
Version? 

Tells you what's new in this version of the 
software. 

Ken Kirkpatrick 
Software on the Web 

Provides links to the following pages on Ken 
Kirkpatrick Software's Web site: Technical 
Support, Home Page, Updates and 
Purchase Software Online. 

About "First Name 
Almanac" 

Displays information pertaining to the 
software and contact information for Ken 
Kirkpatrick Software. 
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Printing the Meaning of a Single Name 

Step 1: Enter First Name  
The first step in creating your document is to enter a name, retrieve its meaning and other data 
from the database and then customize this information as necessary. 

To complete Step 1: Enter First Name: 
1. Enter a first name and select the appropriate gender. The program will automatically 

capitalize the first letter of each name, so you do not need to use the Shift or Caps Lock 
key. 

2. Click Lookup Meaning and Traits.. The meaning and traits display to the right in the 
Edit All Properties area. 

3. Review and edit the information in the Edit All Properties area as needed. Use the 
following table as a guide: 

Printed name The first box shows you how the name will print. You 
may edit this without affecting the name's meaning. 

Origin information The two fields below the printed name tell you the 
origins of the name you have entered. You may also 
change this information as needed. 

American English / 
British English 

Select one of these buttons to indicate which form of 
English you would like to use in the printout. 

Edit Private Name 
Database 

Click this button to edit the Private Name Database . 

Meaning This box explains the meaning behind the name. You 
may change this text. 

Use Secondary 
Meaning / Use Original 
Meaning 

Click this button to switch between the name's original 
and secondary meanings. Many names in the 
database have two meanings. 

List of traits The list of traits associated with the name, such as 
the person's emotional spectrum, personal integrity 
and personality, are displayed below the name's 
meaning. You may edit each of these as you see fit. 

A green check mark in the Print box indicates that the 
trait will be included in the printout. To omit a trait 
from the printed document, just deselect its Print 
check box by clicking it. 

The last trait box is for entering or selecting a 
sentiment to include in the document. For more 
information see Sentiment Lines . 

Preserve Sentiment 
Line 

Select this check box if you would like the software to 
save the sentiment that you have entered in the text 
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box above. 

4. In the Options area, select the options that you want to apply to the document. Use the 
following table as a guide: 

Print Lucky Numbers & 
Astrology 

Select this button to print the lucky numbers and 
astrological information associated with the name. 

Substitute 
Inspirational Verses 

Select this button to print inspirational verses instead 
of lucky numbers and astrology. 

No Numbers/ 
Astrology/ 
Verses 

Select this button to print neither lucky numbers and 
astrology nor inspirational verses. 

Options and 
Preferences 

button  

Click this button to view and modify General Options 
and Preferences . 

Select Birthdate To print the person's birthdate, select the Use & Print 
Birthdate check box, select a month from the list and 
then enter the date in the box to the right. You also 
have the option to enter the year. 

Now you are ready to continue to Step 2: Select a Background . 
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Step 2: Select a Background  
After you have entered a name, you are ready to select the background art. 

Note: First Name Almanac's background art will not show up in the printed document. They are 
shown for alignment and sales purposes only and are intended to give you an approximate 
representation of the finished product when you print to a particular stock available from your 
paper supplier. 

To complete Step 2: Select a Background: 
1. Click the Step 2: Select a Background tab at the bottom of the screen. 

2. From the list of available backgrounds, select the one that you would like to preview. The 
selected background will display to the right. If you do not wish to preview a background 
image, select the No Picture Desired check box. 

Now you are ready to continue to Step 3: Customize and Print . 
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Step 3: Customize and Print  
On the Customize and Print screen, you can modify a number of settings that determine the 
appearance of the final document. 

To customize and print the document: 
1. Click the Step 3: Customize and Print tab at the bottom of the page. 

2. Modify the settings on this screen as you see fit. The following sub-sections explain the 
options found in each area. 

3. Click Preview to preview the document . 

4. Take either of the following steps for generating the document: 

• Click Print Single Name to print the document . 

• Click Create PDF to generate a PDF of the document. 

Printing Options 
In the Printing Options area, you have the following options: 

Note: Orientation settings are automatically determined based on the background you have 
selected. For best results, do not change these default settings. 

Orientation of the 
Paper 

You can select one of the following options: 

• Landscape 
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• Portrait 

Orientation of the Text 
on the Paper (Does not 
appear for dual names) 

You can select one of the following options: 

• Horizontal 

• Vertical 

Mirror Printing Mirror printing, a technique used with heat-transfer 
papers, will produce a mirror image so that you can 
transfer printed output to saleable items such as 
mouse pads and T-shirts. Please make sure you are 
using the proper type of printer and paper before you 
turn on mirror printing. 

To turn on mirror printing, click the Mirror Printing 
button. When it is activated, the button will read 
Mirror Printing On. To turn off mirror printing, click 
the button so that it reads Mirror Printing Off. 

Font Options 
In the Font Options area, you have the following options: 

Default Font 
Black Forest 
Universal Hand 
Nero Bold 

Select one of these buttons to apply that particular 
font to the document. 

Font Size Move the slider left or right to decrease or increase 
the font size. 

Print Name in Ornate 
Font 

Select this button if you would like the name to be 
printed in an ornate font. This option is available only 
in First Name Almanac Professional. 

Select Font Color Click this button to select a font color from the color 
palette. 

Options & Preferences 
Button 

 

Click this button to open the General Options and 
Preferences screen , where you can modify the 
default font settings and other options. 

Current Printer 
In the Current Printer area, you can select the printer to which the document will be sent. To 
change the default printer, click Printer Setup. For more information, see Print Setup . 

Print Centering 
In the Print Centering area, you have the following options: 

Horizontal Micro-
Adjustment 

Click the left and right arrows to move the text 
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horizontally on the page in 1/8" increments. 

Vertical Micro-
Adjustment 

Click the up and down arrows to move the text 
vertically on the page in 1/8" increments. 

Note: The changes you make to the horizontal and 
vertical micro-adjustment will be used for every 
printout until you either modify these settings again or 
quit the program. 

Reset to 0 Click this button to re-center the text on the page. The 
horizontal and vertical adjustments will be reset to 0. 

Load Favorites Click this button to load one of your favorite settings. 
For more information see Loading and Saving 
Favorites . 

Load Defaults Click this button to load the default application 
settings. 
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Printing the Meanings of Dual Names 

Enter Name 1 of 2  
The options that you see on this screen are similar to those you see when entering a single 
name. Please refer to Step 1: Enter First Name for details. 

Note: The settings that you choose for the first name will also apply to the second name, except 
for the birthdate and gender. 

Once you have completed this step, continue to Enter Name 2 of 2 . 

 

Enter Name 2 of 2  
Entering the second name is much like entering the first. 

Note: The settings that you have chosen for the first name will also apply to the second name, 
except for the birthdate and gender. 

To enter the second name: 
1. Click the Enter Name 2 of 2 tab at the bottom of the screen. 

2. Type the name and select a gender as you did for the first name. 

3. Click Lookup Meaning and Traits. The meaning and traits display to the right in the Edit 
All Properties area. You can edit the text of these as you did for the first name. The same 
traits that you selected to print for the first name will also print for the second name. 

4. If you chose to print the birthdate for the first name, select a birthdate for the second 
name as well. 
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You are now ready to continue to Select a Background . 

 

Select a Background  
Selecting a background for dual names is much like selecting one for a single name, with the 
added feature of being able to select a graphic to display between the names. 

To select a background: 
1. Click the Select a Background tab at the bottom of the screen. 

2. From the list of available backgrounds, select the one that you would like to preview. The 
selected background will display to the right. If you do not wish to preview a background 
image, select the No Background Picture Desired check box. 

3. If you would like to print a graphic between the two names, select an image from the 
Dual Name Graphics list. The selected graphic will be included in the printed document 
or PDF. To print an exemplar of the dual-name graphics used by the software, click Print 
Dual Names Graphics Exemplar. 

Now you are ready to continue to Customize and Print . 
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Customize and Print  
The Customize and Print screen for dual names is the same as it is for a single name. Please 
refer to Step 3: Customize and Print for details. 

Note: You cannot change the text orientation for dual names. This setting is determined 
automatically by the software. 
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Mugs & More 

Enter First Name  
Entering a first name for Mugs & More is identical to Step 1 of printing the meaning of a single 
name. Please refer to Step 1: Enter First Name for details. 

After entering the first name, please continue to Select a Specialty Product . 

 

Select a Specialty Product  
First Name Almanac can print names for a variety of specialty products, such as coffee mugs, 
jewelry boxes and Christmas ornaments. 

To select a specialty product: 
1. Click the Select a Specialty Product tab at the bottom of the screen. 

2. From the list on the right, select the product for which you are printing. 

3. If you would like to include the cutout borders in the printout, make sure Print Cutout 
Borders is selected. The borders if the selected product will appear as dashed lines in 
the printout so that you can easily cut out the proper shape with scissors. 

Now you are ready to continue to Select a Background . 
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Select a Background  
Selecting a background for specialty items is as easy as a couple mouse clicks. 

Note: First Name Almanac's background art will not show up in the printed document. They are 
shown for alignment and sales purposes only and are intended to give you an approximate 
representation of the finished product when you print to a particular stock available from your 
paper supplier. 

To select a background: 
1. Click the Select a Background tab at the bottom of the screen. 

2. From the list of available backgrounds, select the one that you would like to preview. The 
selected background will display to the right. If you do not wish to preview a background 
image, select the No Picture Desired check box. 

Now you are ready to continue to Customize and Print . 
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Customize and Print  
The Customize and Print screen for Mugs & More is basically the same as it is for printing a 
single name. Please refer to Step 3: Customize and Print for details. 

Note: You cannot change the text orientation for Mugs & More. This setting is determined 
automatically by the software. You also cannot create a PDF version of the document. 
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Family Tree of Life 

Entering Names and Birthdates on the Family Tree  
Creating a family tree is as simple as entering the names and birthdates and clicking Print. 

Note: The image of the tree will not show up in the printed document. It is shown for alignment 
and sales purposes only and is intended to give you an approximate representation of the 
finished product when you print to a particular stock available from your paper supplier. 

To enter names and birth dates on the family tree: 
1. In the upper-left corner of the screen, enter the family surname. 

2. In the boxes around the tree, enter the first names and birthdates of the individuals in the 
family. You can enter this information as you see fit. 

Note: To see a demonstration of how the Family Tree should look, click the Show Demo 
button in the upper-right corner of the tree. Also, you can clear all names and birthdates 
from the tree at any time by clicking Clear Data. 

3. In the area to the right of the Tree, adjust the placement of the text as you see fit. 
Following are your options: 

Horizontal Micro-
Adjustment 

Click the left and right arrows to move the text 
horizontally on the page in 1/8" increments. 

Vertical Micro-
Adjustment 

Click the up and down arrows to move the text 
vertically on the page in 1/8" increments. 

Note: The changes you make to the horizontal and 
vertical micro-adjustment will be used for every 
printout until you either modify these settings again or 
quit the program. 

Reset to 0 Click this button to re-center the text on the page. The 
horizontal and vertical adjustments will be reset to 0. 

4. Click the Preview button to preview the document . 

5. Click the Print Family Tree of Life button to print the document . 

Note: You can change the printing options in the Font & Printer Options . 
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Font and Printer Options  
To change the font and printer options for the Family Tree of Life, just click the Font & Printer 
Options tab at the bottom of the screen. Your options are as follows: 

Font Options To change the current font and font size, click Select 
Font. Then select a font, font style and size, and click 
OK. 

Current Printer Click Printer Setup to open the Print Setup , where 
you can select the printer on which you would like to 
print the Family Tree. 
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'N' is for Name 

Step 1: Enter First Name and Select Background  
Step 1 of the 'N' is for Name section involves entering a name and sentiment and selecting a 
background image. 

To complete Step 1: 
1. Type a name in the Enter First Name area. 

2. Select either American English or British English. 

3. If you would like to add a sentiment line to the printout, type one in the Optional 
Sentiment Line Here box, or click the box and select a sentiment line that has already 
been saved. To save the sentiment line that you enter, select the Preserve Sentiment 
Line check box. For more information, see Sentiment Lines . 

4. Select a background from the list of background art. Or, to omit the background art, 
select No Picture Desired. 

Now you are ready to continue to Step 2: Select Options and Print .. 

 

Step 2: Select Options and Print  
The options available on this screen are identical to what you see on the Customize and Print 
screen for printing the meaning of a single name. 
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Letters from ... 

Step 1: Select a Letter  
The first step in creating a letter is to enter the child's name and address and select the type of 
letter to be sent. 

To select a letter: 
1. Select either American English or British English. 

2. In the Personalization area, enter a child's first name and select either Boy or Girl. 

3. Enter a city and state (or province). If you would like First Name Almanac to remember 
the city and state the next time you open this screen, select the Remember City & State 
check box. 

4. In the Letters From area, select the letter that you would like to print. 

Now you are ready to continue to Step 2: Select a Background . 

 

Step 2: Select a Background  
First Name Almanac provides a sample background image for each type of letter. 

Note: The background images represent screen copies of popular printed images available from 
your paper supplier. The screen views provide an approximate representation of the finished 
product when printed on the selected stock. These images do not print. They are shown for 
alignment and sales purposes only. 
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To select a background: 
1. Click the Step 2: Select a Background tab at the bottom of the screen. 

2. From the list on the left, select a background image. Or, if you do not wish to view a 
background image, select No Picture Desired. 

Now you are ready to continue to Step 3: Customize and Print . 

 

Step 3: Customize and Print  
The customization options in this section of the application are similar to what you see in the 
other sections. 

To customize and print the document: 
1. Click the Step 3: Customize and Print tab at the bottom of the screen. 

2. Modify the settings on this screen as you see fit. The following sub-sections explain the 
options found in each area. 

3. Click Preview to preview the document . 

4. Take either of the following steps for generating the document: 

• Click Print to print the document . 

• Click Create PDF to generate a PDF of the document. 

Printing Options 
In the Printing Options area, you have the following options: 
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Orientation of the 
Paper 

You can select one of the following options: 

• Landscape 

• Portrait 

Font Options 
In the Font Options area, you have the following options: 

Select Font To change the current font and font size, click Select 
Font. Then select a font, font style and size, and click 
OK. 

Select Font Color Click this button to select a font color from the color 
palette. 

Font Size Move the slider left or right to decrease or increase 
the font size. 

Current Printer 
In the Current Printer area, you can select the printer to which the document will be sent. To 
change the default printer, click Printer Setup. For more information, see Print Setup . 

Print Centering 
In the Print Centering area, you have the following options: 

Horizontal Micro-
Adjustment 

Click the left and right arrows to move the text 
horizontally on the page in 1/8" increments. 

Vertical Micro-
Adjustment 

Click the up and down arrows to move the text 
vertically on the page in 1/8" increments. 

Note: The changes you make to the horizontal and 
vertical micro-adjustment will be used for every 
printout until you either modify these settings again or 
quit the program. 

Reset to 0 Click this button to re-center the text on the page. The 
horizontal and vertical adjustments will be reset to 0. 
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Customizing and Printing 

Loading and Saving Favorites  
First Name Almanac allows you to specify many of settings for each printout, such as the 
background art, text orientation, font size and color and more. To help you enter those settings as 
quickly and easily as possible, we have created a way for you to save a group of settings as a 
"favorite" that can be recalled and applied to documents in the future. 

The use of favorites applies to the printing of name meanings, 'N' is for Names and Mugs & More. 

Saving a Favorite Setting 
Whenever you create a new favorite, First Name Almanac saves the settings you have selected 
for the following items: 

• Background art 

• Paper orientation (Landscape or Portrait) 

• Text orientation (Horizontal or Vertical) 

• Font 

• Font color 

• Font size 

• Left/right adjustment of the text position 

• Up/down adjustment of the text position 

• The flourish that prints to the left and right of the name (see General Options and 
Preferences ) 

• The bold line that prints above and below the meaning of the name instead of the flourish 
(see General Options and Preferences ) 

Note: The birthdate is not saved, as it varies from customer to customer. 

To create a new favorite memory setting: 
1. Create a printout using the settings that you want to save for future use. Be sure to enter 

the values you desire for each of the settings listed above. 

2. Preview the document to make sure it is exactly as you want it to be. 

3. On the Customize and Print screen, click the Load Favorites button. The Load and Save 
Favorites area displays. 
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4. Click New. 

5. In the Save As box, type a name for the favorite. Be sure to use a descriptive name that 
will remind you what the setting is in the future. We suggest using the name of the 
background  artwork plus the type of document for which it was used, such as "Footprints 
- Single Name". You are free to name the favorite setting anything you desire. 

6. Click Save Favorite. Your new favorite is saved and will now appear in the list of 
favorites whenever you are printing. 

Note: First Name Almanac allows you to create an unlimited number of favorites. 

Loading a Favorite Setting 
Whenever you load a favorite into memory, its saved settings are applied to the printout you are 
currently creating. 

To load a favorite: 
1. After you have entered a name and selected a gender, go to the Customize and Print 

screen, and click the Load Favorites button. The Load and Save Favorites area 
displays. 

2. From the list of favorites, select the one that you wish to load. 

3. Click Load this Favorite. The saved settings are loaded into memory. You can now 
preview and print the document. 

Note: Every time you re-enter a particular program section (Print Single Name, Mugs & 
More, etc.), the default settings are loaded so that you are not stuck with the settings you 
used for the last document you printed. 

Editing a Favorite Setting 
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After you have saved a favorite, you can recall it from memory, make changes to its settings and 
save it again. 

To edit a favorite setting: 
1. Load the favorite by following the steps above . 

2. Make any desired changes to the loaded settings. 

3. On the Customize and Print screen, click the Load Favorites button again. 

4. From the list of favorites, select the favorite that you have just edited. 

5. Confirm that the name in the Save As box is the name you wish to use. 

6. Click Save Favorite. Your changes have now been saved. 

Deleting a Favorite 
You can easily delete favorites that you no longer need. 

To delete a favorite: 
1. From the Load and Save Favorites area, select the favorite you wish to delete from the 

list of favorites. 

2. Click Delete This. The favorite is removed from the list. 

Note: You cannot delete the !Default Settings! favorite. 

Previewing Results  
In each section of First Name Almanac, you are allowed to preview a document before you print. 

To view the full-screen print preview: 
1. Click the Preview button on the right sidebar menu. The print preview displays. 

2. Review the document to make sure it is what you want. 

Note: You can modify a few of the printing options in the Preferences window. 

3. To display the printable page area, select the Show Printable Page Area check box in 
the upper-left corner of the screen. This will show you a black outline of the actual 
printable page area of the printer you have selected in the Print Setup . Because some 
printers are unable to print all the way to the paper margins, this handy feature lets you 
make sure your document will not be cropped by the printer. 

4. Click Close Window to exit the print preview. 
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Printing  
In each section of First Name Almanac, after you have customized a document to your liking, you 
can print it by clicking the Print button found on the right sidebar menu. The document will print 
using the settings you have specified in the Print Setup . 

Creating a PDF  
The Portable Document Format (PDF) is a great way to send your documents electronically 
because it is compatible across all computer platforms. The Birthday Chronicle can create a PDF 
version of a document with just a click of your mouse. 

Note: New PDFs are saved in Error! Hyperlink reference not valid. . 

To create a PDF: 
1. Click the Create PDF button on the right sidebar menu. 

 

2. In a few seconds, you will see the following message, which tells you the name of the 
new PDF file and where it has been saved. 
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3. Click OK to continue. You will be given the following option. If you would like to e-mail the 
PDF file to a customer, click Yes. See E-Mailing a PDF for further instructions. 

 

Otherwise, click No to return to the Customize and Print screen. 

E-Mailing a PDF  
Instead of printing a document for a customer, you can also e-mail them a high-quality PDF 
version. 

Note: First Name Almanac also gives you the option to e-mail when you initially create a PDF . 

To e-mail a PDF: 
1. From the File menu, select Send a Selected PDF 

File via Email. 

2. In the Open PDF File dialog box that displays, select 
the appropriate file and click Open. 

 

3. In the e-mail message that displays, enter your customer's e-mail in the To field. You can 
also modify the Subject and Message fields as you see fit. In the Attachment field, you 
will see the name of the PDF you have selected. If necessary, you may click Browse and 
select a different file to send. 
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Note: The default text that appears in these fields can be modified in the PDF Options . 

 

4. Click Send to send the e-mail. With some e-mail programs, you may see a message 
similar to the following. This is simply a warning that First Name Almanac is attempting to 
send an e-mail using your e-mail program. Be sure to allow this access. 

 

5. First Name Almanac will interface with your e-mail program and send the message. 
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Additional Features 

Editing the Private Name Database  
In addition to the permanent database of more than 250,000 names, First Name Almanac also 
provides a separate private name database in which you can save your own names, along with 
their meanings and other details. Whenever you search for a name, the private name database 
takes precedence over the permanent database. That is, if the same name is found in both 
databases, the private database entry will be displayed instead of the permanent entry. This 
handy feature allows you to customize names and their meanings to suit your customers. 

To access the private database editing screen: 
From the Edit menu on the home screen, select Edit Private 
Name Database. You can also access this screen by clicking the 
Edit Private Name Database button found on the Step 1 screen 
when you are printing the meaning of single or dual names. 

 

The private database editing screen displays. The following sections explain the options you see 
on this screen. 
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Adding a New Name 
You can add as many names as you like to the private name database. If you add a name that 
already exists in the standard database, you are in effect overriding the permanent entry. 

To add a new name: 
1. Click Add New Name. 

2. In the First Name box, type the name you want to add. Be sure to spell it correctly, as 
the program will only be able to find exact matches when you search. 

3. Enter the appropriate information in the Local Country of Origin, Civilization of Origin, 
Root or Base Name, and Meaning fields. The example name "Danny" is provided as a 
model for how you should complete these fields. 

4. Click Update Database. The record is saved in the private database. 

Deleting a Name 
Deleting a name from the private database is as easy as finding it and clicking Delete. 

To delete a name: 
1. In the Find and Edit Name in Private Database area, type a name in the box. 

2. Click Search. If a match is found, the name's details will display in the Add and Edit 
Names to Private Database area. 

3. Click Delete Name. The record is removed from the database. 

Editing a Name 
After finding a name in the private database, you can edit its details and save your changes. 

To edit a name: 
1. In the Find and Edit Name in Private Database area, type a name in the box. 

2. Click Search. If a match is found, the name's details will display in the Add and Edit 
Names to Private Database area. 

3. Edit the fields as you see fit. 

4. Click Update Database. The record is updated. 

Deleting the Database 
You can delete the entire contents of the Private Name Database by clicking Delete Database. 
This will erase every name in the database except for the example name "Danny". Don't worry — 
this will not affect the thousands of names found in the permanent database. 

Sentiment Lines  
When you are printing the meaning of single or dual names or using the 'N' is for Name or Mugs 
& More feature, First Name Almanac allows you to personalize the printout by adding a sentiment 
line which will appear in the document. This sentiment line could be any text that you wish to 
enter. The program will remember the last fifty sentiment lines entered. You also have the option 
of preserving a sentiment line so that it does not get erased automatically. 

To preserve a new sentiment line: 
1. In the Optional Sentiment Line Here box, enter any text you desire. 
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2. Select the Preserve Sentiment Line check box. First Name Almanac will save the 
sentiment so that it is not deleted after more then fifty additional sentiments have been 
entered. 

To delete a sentiment line: 
1. Click the sentiment line list box and select the line that you wish to delete. 

2. Press the Delete key on your keyboard. The line is deleted. 
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Settings 

General Options and Preferences  
To access the general options and preferences, go to the Preferences menu on the home screen 
and select General Options and Preferences. 

Startup Defaults 
The Startup Defaults area lets you specify an assortment of settings to be applied each time you 
launch First Name Almanac. Many of these default settings can be modified for each document 
that you print. Your options are as follows: 

Define Lucky Number 
Range 

To change the range of lucky numbers, use the up 
and down arrows to increment or decrement the 
upper limit. Lucky numbers are randomly chosen from 
the numbers between 1 and the upper limit that you 
specify. 

Substitute 
Inspirational Verses 
Instead of Lucky 
Numbers - No 
Astrology 

Select this button to print inspirational verses by 
default instead of lucky numbers and astrology. This 
setting can be modified for each document you print. 

Print NO Numbers, NO 
Astrology, NO Verses - 
Nothing 

Select this button to make this the default print 
setting. No lucky numbers, astrology or inspirational 
verses will be printed. This setting can be modified for 
each document you print. 

Use Southern 
Hemisphere Dates for 
Astrology Sun Signs 

Select this button to use southern hemisphere dates 
for astrology sun signs instead of northern 
hemisphere dates. 

Substitute Bold Line 
Above & Below 
Meaning of Name 

When this box is selected, bold lines will print above 
and below the name instead of the decorative curly 
cues. 

Print "flourish" 
before/after name 

When this box is selected, decorative flourishes will 
print to the left and right of each name. 

Use this background 
art as my startup 
image 

Select one of the background images from this list to 
make it the default art chosen for each document. 

Default Font 
Black Forest 
Universal Hand 
Nero Bold 

Select one of these options as your default font at 
startup. 

Use & Print Birthdate Select this check box to print a birthdate for each 
name by default. You can modify this default setting 
when you enter a name. 

After making changes to the startup defaults, be sure to click Save These Settings. 
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Dual Names Graphics 
In the Dual Names Graphics area, you can print an exemplar of the graphics that you can select 
to print between dual names. 

 

Resetting the Print Counter  
On the menu bar at the top of the screen, you'll see a counter that tells you how many documents 
have been created. 

To reset the counter: 
1. From the Special menu, select Reset Count. 

The first time you select this option, you will be asked to 
select a password that will be required anytime you wish to 
reset the counter. 
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2. Enter the password in the appropriate fields and click OK. The counter will be reset to 
zero. Anytime you attempt to reset the counter in the future, you will need to enter the 
same password. Be sure you don't forget it! 

Note: If you do not want to password-protect the counter-reset function, select the check 
box at the bottom of the dialog box. You will not need to select a password. 

Editing the Dealer Tag Line  
At the bottom of every printed page and PDF document, First Name Almanac prints a tag line that 
can contain any text that you specify. 

To edit the dealer tag line: 
1. From the Special menu, select Edit Dealer Info. 

2. In the window that displays, type your text in the Dealer 
Tag Line box. You are free to enter anything you'd like, 
such as your business name, address or a simple 
message. 

Note: If you do not enter a tag line, nothing will print at the bottom of the page. 

3. In the Tag Line Font Size area, select the size you would like the dealer tag line text to 
be. 

4. Click Done. 

 

PDF Options  
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You can access the PDF Preferences screen by clicking the PDF Options button found on the 
sidebar menu of the Customize and Print screen. Here you can specify the default e-mail subject, 
message text and signature that will be used whenever you e-mail a PDF to a customer. To make 
changes to the default text, simply click in the box and type your own. Be sure to click Save when 
you are finished. 

 

Print Setup  
The Print Setup allows you to set up your printer to work with First Name Almanac. 

To set up your printer: 
1. From the File menu, select Print Setup. The Print 

Setup dialog box displays. 

2. In the Printer area, select a printer from the Name 
dropdown list. This will be the default printer to which 
the program will print. If you are already using a 
printer with your computer, it should appear in this list. To further specify printer settings, 
click the Properties button. 

Note: To select a network printer, click the Network button 

3. In the Paper area, select the paper size and source. We recommend that you use the 
default settings. 

4. In the Orientation area, select either Portrait or Landscape. 

5. Click OK. 
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Contact Ken Kirkpatrick Software  
Ken Kirkpatrick Software 
Taft, CA 93268-0389 
United States of America 

661.763.3545 
866.250.9117 Fax (toll free in the U.S.A.) 

www.kksoft.com  

support@kksoft.com  
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